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OVERVIEW 

The Saleng Build-Your-Own-Arduino (BYOA) is a complete, 

Open Source Hardware, locally made kit to build your own 

Arduino Uno. The kit includes the microcontroller 

ATmega328P-PU which comes pre-installed with the same 

bootloader used in the Arduino Uno. It also follows the 

Arduino Uno pin assignments and is hence programmed 

using the same Arduino IDE. Also included is a pre-

fabricated PCB and all the other components required to 

complete the board. The schematic and example PCB 

layout has been provided should the user decide to self-

fabricate the PCB. 

This kit requires the user to solder the components. All 

components have been selected as leaded through-hole 

devices to facilitate ease of soldering.  

Programming the completed board will require a separate 

Serial-USB converter module or another Arduino 

Uno/Nano/Mega board to serve as programmer.  

NOTE: Before you continue, do note that this kit is meant 

to be built by the user. Soldering is required and a 

separate Serial-USB programmer (or Arduino) is needed 

for programming the board. 

This kit is designed as a learning tool and also as an 

alternative to the Arduino Uno in projects where space or 

cost is a priority. 

 

CONTENTS 

 

The kit contains the following components. See figure 1 

and table 1. 

 

Label Item Description Quantity 
U1 ATmega328P-PU with Bootloader 

Installed 
1 

U2 7805 5V/1A Regulator, TO-220 1 

D1 1N4001/1N4004/1N4007 1 

LED1 3mm LED, Red 1 

LED2 3mm LED, Blue/Green or Yellow 1 

Y1 16MHz Crystal  1 

C1 100uF, >=16V Electrolytic Capacitor 1 

C2,C5,C6 0.1uF(104) Multilayer Ceramic 
Capacitor 

3 

C3,C4 22pF(22 or 220) Multilayer Ceramic 
Capacitor 

2 

R1 10 Kilo ohms, 1/4w resistor 1 

R2,R3 1 Kilo ohm, 1/4w resistor 2 

H1,H2 14-pins Male Pin Headers 2 

H4/Prog 
Port 

5-pins Male Pin Headers 1 

S1 Tactile Push Button, NO 1 

- 28-pin IC holder for U1 1 

- Pre-fabricated PCB 
Note:User may decide to custom 
build the PCB. See Appendix for 
example designs 

1 

 

 

CIRCUIT  

 

The circuit revolves around the ATmega328P-PU 

microcontroller, the same IC used in the Arduino Uno. The 

whole design was implemented in the included PCB 

following the schematic. For optimum cost, the circuit 

does not include a Serial-to-USB converter for 

programming, rather, an external converter (or Arduino) 

can be used. See the Programming section for details. 

 

 

 

Figure 1: The Saleng BYOA Kit 
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The circuit is powered by the 7805 (U2) 5V regulator IC 

preceded by the reverse-polarity protection diode D1. The 

red LED1 indicates if the 5V power is present. Y1 and the 

22pF capacitors C3 and C4 form the 16MHz oscillator 

clock source of the microcontroller. The reset pin of the 

ATmega328P-PU is active low, hence, R1 is included to 

pull this line to Vcc during normal operations. Pressing the 

tactile button S1 will cause the reset line to go low and 

thereby resetting the microcontroller. C6 is included to 

allow auto-reset via the DTR of the 

programmer/converter. LED2 is connected to pin D13 

following the design of the Arduino Uno. When using D13, 

consider the effect of the LED in designing the external 

circuit. 

 

TOOLS/MATERIALS FOR ASSEMBLY 

 

To assemble the board, the following are required: 

 Soldering Iron 

 Soldering Wire (flux/rosin core) 

 Side/Diagonal/Wire cutter for cutting extra leads 

of the components 

 We also recommend Safety/Personal Protective 

Equipment: Safety Goggles, Gloves, Fume 

Extractor, Ground Strap/Mat, etc. 

 

SUGGESTED ASSEMBLY PROCEDURE 

 

1.  Identify the component side of the PCB, this is 

where you will insert the components. Refer to 

the figures below: 

 

 

2. Start soldering the smaller/shorter components: 

R1,R2,R3 and D1. Note the correct orientation of 

 

 
Figure 3: Saleng BYOA Schematic Diagram 

 

 Figure 2: Component Side of the PCB 
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D1, the cathode (stripped side) goes to the pad 

labeled ‘K’. Bend the leads at the bottom side to 

keep the components in place or use tape at the 

component side. Flip over the PCB and solder all 

these 4 components. 

3. Solder Y1, C2,C3,C4,C5,C6 in any order following 

the previous procedure. 

4. Install the 28-pin IC holder in the slot labeled U1. 

Follow the orientation of the notch with that in 

the PCB. The notch should face S1 side. 

5. Solder U2, C1 and S1. 

6. Solder the headers. You may decide to have the 

14-pin headers at the component or bottom side. 

Having them at the bottom allows direction 

insertion in a breadboard while installation on the 

component side allows ease of inserting wire-

connectors. The 5-pin programming header 

should be installed on the component side. 

7. Clean the circuit board of excess flux. 

 

 

PROGRAMMING/USAGE 

 

As previously mentioned, this board does not include a 

Serial-USB conversion circuit and must therefore use an 

external converter, either a module or using another 

Arduino. This is the same arrangement in the Arduino Pro-

Mini and other Arduino compatible boards with 

minimalistic features.  

The converter is necessary for programming the board via 

the serial/bootloader approach. This is also necessary to 

use the Serial Monitor or Plotter tool of the Arduino IDE. 

 

Serial USB Converter 

 

Serial-USB converter modules come in several brands, 

features and configurations that selection may not be as 

straightforward. There is also the option to use another 

Arduino as the converter circuit. Below is a simple guide 

to help the user decide on what converter to get. 

 

 Converter chip: FTDI xxxx, Prolific xxxx, CH340G, 

Silicon Labs CP2xxxx or the ATmega16U2 internal to 

some Arduino boards among others may be used. 

There is no preference in this aspect. Make sure the 

USB drivers of the converter chip are installed in your 

working computer. The drivers should be found online 

and some computers may install them automatically. 

 Signals: At a minimum, the RXD and TXD pins should 

be exposed. Ideally though, the DTR signal is also 

broken out to allow auto-reset function during 

programming. Without the DTR signal, the converter 

will still work but you will need to manually press the 

reset button just before the upload sequence starts. If 

the DTR signal of the converter is available, connect it 

to the DTR pin of the Saleng BYOA and the setup 

should automatically perform the reset. 

 Power: Common USB-serial dongles should have the 

5V power pins exposed. You can use these to power 

the Saleng BYOA during programming.  

 Dongles with an option to switch between 5V and 

3.3V logic is an extra added feature to look out for for 

use in 3.3V systems. This is technically not required in 

the BYOA as it is fixed at 5V, but is a good addition 

when looking for a converter. 

 We recommend using the Layad Circuits’ Kimat USB-

UART dongle as this device was designed specifically 

for programming the Saleng BYOA or Arduino Pro 

Mini and has all the desired features discussed herein. 

 

 

 

 

 

 

 

 

 
Figure 4: Setup for Programming 

 Figure 5: Kimat USB-UART Converter/Programmer 



 
  

Revision: v1.0 / 09 August 2019/ V.Mendoza/D.R.Gatto/ C.D.Malecdan 

www.layadcircuits.com                                                                                  Copyright 2019 © Layad Circuits All Rights Reserved 
Layad Circuits Electronics Engineering Supplies & Services, B314 Lopez Bldg., Session Rd. cor. Assumption Rd., Baguio City, Philippines 
General inquiries: info@layadcircuits.com   Sales: sales@layadcircuits.com    FB: facebook.com/layadcircuits    Mobile: +639164428565 

An IMPORTANT NOTICE: at the end of this guide addresses availability, warranty, changes, use in safety-critical applications, intellectual property matters and other 
important disclaimers. 

    4 
 

  Saleng B.Y.O.A. (Built Your Own Arduino) Kit 
                                                        User Guide 

 

 

 

 

 

 

Programming Using Another Arduino Board 

 

This procedure follows how the Arduino Pro Mini is 

programmed using another Arduino Board.  

 

The procedure described herein uses an 

Uno/Nano/Mega/Leonardo SMD or DIP version. Manual 

press of the reset button of the Saleng BYOA is required.  

This method does not require removal of the 

microcontroller IC on the Arduino board. 

 

To program follow the steps below: 

 

1) Prepare your Arduino board by uploading a 

“blank” code. The blank code is an empty setup() 

and loop() or simply generate one by going to 

File>New. Upload this to the Arduino board. Let 

us call this board the “programmer”. To upload 

the code: 

 connect the Arduino to the computer 

using a USB cable 

 Tools>Ports and select the appropriate 

COM port 

 Tools>Board and select the appropriate 

COM port. Select Arduino Uno if you are 

using a Saleng Uno as programmer 

 Hit the Upload Button (arrow icon) 

 

 
Figure 6 A "blank" code 

2) Connect the programmer board to the target 

board following the diagram or table below. The 

“target” board is the Saleng BYOA. 

 
Figure 7: Programming the Saleng BYOA with an Arduino 

PROGRAMMER: 
Arduino/Saleng Uno/ 
Nano/ Mega 

TARGET: 
Saleng BYOA 

5V VCC 

GND GND 

D1 TX 

D0 RX 

 DTR – not connected 

Note: RESET is 
connected to GND 

 

 

Note that in this case, the programmer Arduino 

board acts only as a USB-Serial converter bridge 

and that the microcontroller is disabled with the 

reset line pulled to GND. 

3) Next, open or write your code. 

4) Tools>Boards>Arduino Uno 

5) Tools>Ports> and select the correct port of the 

programmer 

6) Hit the Upload Button (arrow icon) 

7) Wait for compilation to complete 

8) As the upload proper starts you should see “Using 

Port…” and “Using Programmer…” at the console. 

At this time , long press the reset button of the 

Saleng BYOA for around 1 second and then 

release. 

9) Wait until upload is completed. 
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Programming Using a USB-Serial Converter without DTR 

 

If your USB-Serial dongle/module does not have the DTR 

pin exposed then follow this procedure. This will require 

manually pressing the reset button of the Saleng BYOA at 

the right moment. Make sure your dongle/module is at 5V 

logic.  

1) Connect as per the table below: 

 

 

 

 

 

 

 

 

 

2) Connect the converter to the computer via the 

USB port 

3) Next, open or write your code. 

4) Tools>Boards>Arduino Uno 

5) Tools>Ports> and select the correct port of the 

programmer 

6) Hit the Upload Button (arrow icon) 

7) Wait for compilation to complete 

8) As the upload proper starts you should see “Using 

Port…” and “Using Programmer…” at the console. 

At this time , long press the reset button of the 

Saleng BYOA for around 1 second and then 

release. 

 
9) Wait until upload is completed. 

 

 

 

 

 

 

 

 

Programming Using a USB-Serial Converter with DTR 

 

If you are using a USB-Serial dongle/module with the DTR 

pin exposed such as in the Kimat USB-UART Converter, 

there is no need to press the reset button. This makes this 

method the recommended way to program the Saleng 

BYOA.  Make sure your dongle/module is at 5V logic.  

   

1) Connect as per the table below: 

PROGRAMMER: 
USB-serial converter with 
DTR 

TARGET: 
Saleng BYOA 

5V VCC 

GND GND 

RXD TX 

TXD RX 

DTR DTR 

Below is the connection diagram using the Kimat USB-

UART converter: 

 

 
 

 

 

 

 

 

 

 

 

PROGRAMMER: 
USB-serial converter 
without DTR 

TARGET: 
Saleng BYOA 

5V VCC 

GND GND 

RXD TX 

TXD RX 

 DTR – not connected 
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 APPENDIX

Example Custom-PCB designs and Etching Instructions 

There are 2 example PCB layouts designed in Fritzing described below. Both follow the schematic diagram specified in 

the Saleng BYOA User Guide document. Also in this section are the suggested instructions in etching the custom PCB 

using a single sided pre-sensitized, positive acting, PCB. 

Example PCB Layouts:  

Design 1: “Vincent”  Design 2: “Diana” 
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Part Placement Guide for the Vincent Design. Top 
View. 
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Final Product of the Vincent Design 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Etched PCB of the Diana Design 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Final Product of the Vincent Design 
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Suggested Instructions 

1. Cut the presynthesized pcb and the acetate into a desired shape. Remove the white protective film of the 

presynthesized pcb and overlap it on the acetate. Work in subdued light. Do not touch its surface and keep it 

safe from contaminants. 

Tip: Overlapping two or more  acetate layouts create a darker pattern thus creating a better  result. 

  

 

 

 

 

 

 

 

2. Expose the PCB on a 25watt CFL light bulb. Make sure that the acetate is laid firmly flat on the PCB. 

Exposure time varies with UV intensity, distance to light source, PCB quality etc. The PCB examples in this 

document were exposed for 50 minutes. 

 

 

  

 

 

 

 

 

3. After exposure, fill a plastic container with water and dissolve the developer. Agitate the PCB in the 

container until all pattern becomes visibly clean.  Do not dissolve all the developer solution, dispense slowly 

until desired strength of solution is acquired. 
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4. When patterns are visibly clear, rinse the PCB in water. Pour ferric chloride (or other etching solution) into 

another container and etch. Rinse in water when the unwanted copper is removed.  

 

 

  

 

 

 

 

5. Drill all the necessary holes on the PCB 
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6. Test the PCB for shorts and open tracks. Scrape off short circuits using a cutter knife of sharp tool. Fix 

open/cut tracks with solder wire. 

Tip: If you want to remove the green coating, you can remove it with acetone or alcohol. 

  

 

 

 

 

 

 

 

 

7. Mount all devices at the component side. Watch out for the orientation of the diode, LED’s, IC’s and 

polarized capacitor. Use tape to temporarily hold the components if necessary. Flip over and solder the leads. 

 

 

 

 

 

 

 

 

 

8. Test the assembled board. Happy Building! 
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IMPORTANT NOTICE 
Layad Circuits Electronics Engineering Supplies & Services (Layad Circuits) reserves the right to make corrections, enhancements, improvements and other changes to 

its products, services and documentations, and to discontinue any product or service. Buyers or clients should obtain the latest relevant information before placing 

orders and should verify that such information is current and complete. Additional terms may apply to the use or sale of Layad Circuits products and services.  

Reproduction of significant portions of Layad Circuits information in Layad Circuits datasheets or user guides is permissible only if reproduction is without alteration, 

displays the Layad Circuits logo and is accompanied by all associated warranties, conditions, limitations, and notices. Layad Circuits is not responsible or liable for such 

reproduced documentation. Information of third parties may be subject to additional restrictions. Resale of Layad Circuits products or services with statements 

different from or beyond the parameters stated by Layad Circuits for that product or service voids all express and any implied warranties for the associated Layad 

Circuits product or service. Layad Circuits is not responsible or liable for any such statements.  

Buyers and others who are developing systems that incorporate Layad Circuits products (collectively, “Designers”) understand and agree that Designers remain 

responsible for using their independent analysis, evaluation and judgment in designing their applications and that Designers have full and exclusive responsibility to 

assure the safety of Designers' applications and compliance of their applications (and of all Layad Circuits products used in or for Designers’ applications) with all 

applicable regulations, laws and other applicable requirements. Designer represents that, with respect to their applications, Designer has all the necessary expertise 

to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood 

of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any applications that include Layad Circuits 

products, Designer will thoroughly test such applications and the functionality of such Layad Circuits products as used in such applications. Layad Circuits’ provision of 

technical, application or other design advice, quality characterization, reliability data or other services or information, including, but not limited to, reference designs 

and materials relating to evaluation modules, (collectively, “Layad Circuits Resources”) are intended to assist designers who are developing applications that 

incorporate Layad Circuits products; by downloading, accessing or using Layad Circuits Resources in any way, Designer (individually or, if Designer is acting on behalf 

of a company, Designer’s company) agrees to use any particular Layad Circuits Resource solely for this purpose and subject to the terms of this Notice.  

Layad Circuits' provision of Layad Circuits Resources does not expand or otherwise alter Layad Circuits’ applicable published warranties or warranty disclaimers for 

Layad Circuits products, and no additional obligations or liabilities arise from Layad Circuits providing such Layad Circuits Resources.  

Layad Circuits reserves the right to make corrections, enhancements, improvements and other changes to its Layad Circuits Resources. Layad Circuits has not 

conducted any testing other than that specifically described in the published documentation for a particular Layad Circuits Resource.  

NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER LAYAD CIRCUITS INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY 

TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF LAYAD CIRCUITS OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, 

copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which Layad Circuits products or services are used. 

Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement 

thereof. Use of Layad Circuits Resources may require a license from a third party under the patents or other intellectual property of the third party, or a license from 

Layad Circuits under the patents or other intellectual property of Layad Circuits. Layad Circuits RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. LAYAD 

CIRCUITS DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED 

TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 

PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS. LAYAD CIRCUITS SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR 

INDEMNIFY DESIGNER AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF 

PRODUCTS EVEN IF DESCRIBED IN LAYAD CIRCUITS RESOURCES OR OTHERWISE. IN NO EVENT SHALL LAYAD CIRCUITS BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, 

COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF LAYAD CIRCUITS RESOURCES 

OR USE THEREOF, AND REGARDLESS OF WHETHER LAYAD CIRCUITS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Unless Layad Circuits has explicitly 

designated an individual product as meeting the requirements of a particular industry standard, Layad Circuits is not responsible for any failure to meet such industry 

standard requirements. Where Layad Circuits specifically promotes products as facilitating functional safety or as compliant with industry functional safety standards, 

such products are intended to help enable customers to design and create their own applications that meet applicable functional safety standards and requirements. 

Using products in an application does not by itself establish any safety features in the application. Designers must ensure compliance with safety-related 

requirements and standards applicable to their applications. Designer may NOT use any Layad Circuits products in life-critical applications. Life-critical medical 

equipment is medical equipment where failure of such equipment would cause serious bodily injury or death (e.g., life support, pacemakers, defibrillators, heart 

pumps, neurostimulators, and implantables). Designers agree that it has the necessary expertise to select the product with the appropriate qualification designation 

for their applications and that proper product selection is at Designers’ own risk. Designers are solely responsible for compliance with all legal and regulatory 

requirements in connection with such selection. Designer will fully indemnify Layad Circuits and its representatives against any damages, costs, losses, and/or 

liabilities arising out of Designer’s noncompliance with the terms and provisions of this Notice. 


